Resource management
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A Resource is:

Any asset that we require to perform a
certain task.

Project Resources:

The sum of resources required to perform all
the tasks of the project
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@9 Types of Resources

In the projects we use various types of
resources:

 Human Resources

« Machinery, tools and equipment
« Capital

* Third party services

« Materials (consumables)
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B9 Definition of the Resource List

In MIS Project, information on resources is
captured in three categories:

» “Work” (people and equipment)
« “Material” (consumables)
e “Cost”
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@Y Definition of the Resource List

To enter the information on the resources, use
the "Resource Sheet" view.

To access this view, on the ribbon menu select
VIEW | Resource Views | Resource sheet.

ject View Help Format

”‘Ez.-| |ﬁ__-|RESDurEE' Usage -
&

= 5 Resource Sheet -
Team

Planner = r,_ Other Views ~

Resource Views
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@7  Definition of the Resource List

You can also use the "RESOURCE" tab to access the
"Resource Sheet" view.
Select RESOURCE| Team Planner | Resource sheet.

diendar

Resource Usage
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@Y Definition of the Resource List
When selecting the “Resource Sheet” view, a table is

displayed where the main data of the project's resources
can be entered.

ile Task Resource Report

Project View Help

Format £ Tell me what you want to do
'F 82 @ ‘-.; | == i - D Leveling Options
Es [l af “n = o om :
s _ = ' 3= Clear Leveling
[eam Resource Add Information Notes Details Level Level
inner - Pool = Resources - Resource  All
View Assignments Insert Properties Level
|JLI| 18 21 |JLI| 23, '21 IAug 1,21 |£-‘L|g 8 '21 |Aug 15, 21 |AL|g 22, '21 |AL|g 29, '21 |Sep 3,21 |Sep 12,
Start : i :
Fri 7/16/21 Add tasks with dates to the timeline
© Resource Name ¥ | Type » Material > Initials > Group = Max ¥ Std.Rate » OvtRate v Cost/Use = Accrue ~ Base » (Code >
1 Resource 1 Work R 100%  S0.00/hr  $0.00/hr $0.00 Prorated Standard
2 Resource 2 Work R

100%  $0.00/hr  S$0.00/hr $0.00 Prorated Standard
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@ Available Fields on Resource Sheet

The main fields available in MS Project for resources are
described below:

ID (# identification): Consecutive resource number generated
automatically by MS Project. 1, 2, etc..

Resource Name: Name description of the resource.

ile Task Resource Report Project View Help Format £ Tell me what you want to do
F‘_-' [ A & [sa=] = o mm [ Leveling Options
=S (v &y, = = e ->m )
b 3 ; %= Clear Leveling
feam Resource Add Information Notes Details Level Llevel
nnnnn Pool - Resources ~ Resource  All
gnments | Inset | Pro perties |
|JLI| 8 '21 |Ju\ 25,'21 |Aug 1,21 |£-\L|g 8 21 |Aug 15,21 |Aug 22, '21 |Aug 29, '21 |Sep 5 '21 |Sep 12,
Start . 2 :
Fri 7/16/21 Add tasks with dates to the timeline
0 R Nam Type . » Std.Rate » Ovt Rate = Cost/Use » Accrue - Base
Resource 1 Work R 100%  $0.00/hr  S0.00/hr 50.00 Prorated Standard
Resource 2 Work R 100%  50.00/hr  $0.00/hr 50.00 Prorated Standard
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B2 Available Fields on Resource Sheet
Email address: This field is not found by default in the
'Resource sheet'. It can be found in the "Resource
Information" window, in the "General" tab.

Here's how to access the field.
Option 1: Double click on the resource, in the "General" tab of

the "Resource Information" window, locate the "Email

nnnnnnnnnnnnnnnnnnn *

Resource name; | Resource 1

Email: Group:

Inactive

Available From | Available To | Units i) change Working Time ...
MNA NA 100%
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Option 2: On the Main Resource sheet, on the resource name
menu, right click, insert column, select Email address (column
will appear)

0 Resou Al > {Type ¥ it
Resource 1 Work
Resource 2 Work =2 Copy
b w p Text
Insert Column
Hide Column
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@9 Available Fields on Resource Sheet
Type: Specify the type of resource. Select a value from those
available in the combo: Labor (for human resources and

equipment), Material (for consumable resources) and Cost (for
financial resources).

File Task  Resource Report  Project View Help Format £ Tell me what you want to do
& @ = o = Leveling ©
5 & & s &g | i~ ) Leveino op
a8 = > Clear Leveling
source Information Notes Details Level Level
Planner~ | Resources Pool~ | Resources~ urce
eeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeee
[Jul 2,21 25,2 Aug 1, ‘2 \ug 8, 2 Aug 15, ‘21 jAug 22, 21 [Aug 29, 21
Start ; " ”
EEThERY | Add tasks with dates to the timeline
0 m e v
eeeeeeee Work % $0.00/hr S /b S rorated dard
eeeeeeeee Material R $0.00 $0.00 Prorated
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B9 Available Fields on Resource Sheet

Material Label: For material resources. It is a text type field (not
included as a standard by MS Project, as you can type any type
of material) where you must type a description of the material's
consumption measurement: kilos, meters, units, etc.

The unit of measure for consumption may be different from the
unit of measure for the material purchase.
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@9 Available Fields on Resource Sheet
Group: Identification label of the resource group to which it
belongs. It is a text type field (not validated by MS Project)
where you can type a common label for several resources. This
label can be used to consolidate information by “Group” of

resources.
Examples:
[ ]
"Implementation team", "Consultants", "Supervisors"
p ) ) p *
File Task Resource Report Project View Help Format 2 Tell me what you want to do
— ® - [eo=] === =[] Leveling Option:
[ % =
|E_ “‘ a4 &y, == | Y om »
Ti Resource Add Information N Detaill evel |
Planner ~ Pool~ | Resources~ | | Selection Resource  All
\ nments Insert Properties . level
w [ oiey
o | ‘Ju\ 821 Jul2s, 21 5,21 Aug 22, '21 |Aug 29, 2
E | Add tasks with dates to the timeline
@ Type ~|_Group ¥ | Pax. ¥ Std.Rate v Ovt Rate v Cost/Use » Accrue v Base
Resource 1 Work Consultants 100%  S0.00/hr  $0.00/hr $0.00 Prorated  Standard

$0.00 $0.00 Prorated
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B9 Available Fields on Resource Sheet

Maximum capacity: It is used for “Work” type resources and
establishes their availability for the project. The value can be
displayed as a percentage value or as decimal units.

Units indicate the percentage of a work resource's time that is
assigned to a task. There are two types of units in Project:
maximum units and assignment units.

Maximum units: When you want to specify how much time a
work resource has available for work on all tasks in a project.
This total is used to calculate how much time a work resource
can spend on each task assignment.
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Assignment units: When you want to specify how much of a
work resource's time is dedicated to a specific task. You also
specify assignment units for material resources to indicate the
qguantity of material being used for the assignment.

e 100% or 1: indicates that a resource is available. 300% or 3:
indicates that there are three resources available.

e If you have 10 operators, you can enter 1000% in the
maximum capacity field.
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@9 Available Fields on Resource Sheet
Maximum capacity - Procedure to modify the format of the
displayed value.

Project Options ? X

Generzl 2 Change options related to scheduling, calendars, and calculations.

Display Select FILE
| Schedule Calendar options for this project: | & Practice W1 -|

Praofing Week starts on: | Sunday '_I

I

Save Fiscal year starts in: lJanuary il

Language - 5

Advanced Default start time: |8QQ5M - | These times are assigned to tasks when you enter a start or

finish date without specifying a time. If you change this

Default gnd time: |Ww setting, consider matching the project calendar using the

Customize Ribbon

Hours per day: ! z| Change Working Time command on the Project tab in the
Quick Access Toolbar — ribbon.
Hours per week: | 40 =
Add-ins «
Days per month: | 20 = | 2 -
. And modify the parameter "Show allocation
Theaule units as:": Percentge or Decimal

~| Show scheduling messages “.

Show assignment units as a: | Percentage ;v{
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B9 Available Fields on Resource Sheet

Standard rate: This rate allows you to pay for the use of
resources in the project.

* If itis a “Work” type resource: The cost x unit of time is
indicated, in normal time. For example: cost per hour of the
resource.

e Overtime rate: Cost x unit of time in overtime, for
“Work” type resources.

* If it is a "Material" type resource: The unit cost of the
resource is indicated, according to the unit of measure
described in the column "Material Label".
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@ Available Fields on Resource Sheet

Cost / Use: Cost of using the resource. This cost is accumulated
in each task that uses it, regardless of its duration.

Example: The rental of a wagon may have a fixed cost which is
the cost per use. In addition to this cost, the standard rate is
defined, which will generate a variable cost that depends on the
work to be done.

]

I ask Resource Report Project View Help Format £ Tell me what you want to do

— 3% Cut = —
B : u oz Jir o] e e B Mark on Track : | 3
Gantt ¥ Copy - Inspect b,;i.e k
h ¥ Format P B I U O-A-

Clipboard FORt = Schedwe Tagks . |nsert

“ ik Nar _ Email Address Ty[ ateria Initials > Group » Max. > Sid.Rate » Ovt Rate Cost/Use crue w fBase
1 Resource 1 Work R Consultants 100%  $0.00/hr  50.00/h 50.00 Prorated [Ftandard
Resource 2 Material R Supervisors 50.00 50.00 Prorated
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B9 Available Fields on Resource Sheet

Accrue at: Defines the way to record the cost of the
resource (standard and overtime rate): Start (recorded at
the beginning of the task), Prorated (recorded
proportionally to the progress of the task) and End
(recorded at the end of the task ).
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@7 Available Fields on Resource Sheet

o If "Start" is used, 100% of the cost is accumulated as real
cost by having at least 1% progress of the task.

 If “Proration” is used, the cost is accumulated in
proportion to the percentage of progress of the task.

 If “End” is used, 100% of the cost is accumulated until the
task is 100% complete
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@7 Available Fields on Resource Sheet

Base calendar: Applicable calendar for scheduling the resource.
You can define specific schedules for the project, for resources and
tasks. They are all created in the PROJECT | Properties | Change work

time.
This parameter establishes the base calendar to be used for the

resource, the calendar that defines its working hours.

file Task  Resource Report Project View Help Format £ Tell me what you want to do
= e b cut = T - !
= h d Calibri 111 - - S Mark on Track r';'?
. 2 Copy ~ e
N T:
& ¥ Format Painter B I U 2 - A spect e ‘
lipboard Font Schedule Tasks. . |nsert
©® Rresource Name » Email Address > Type > Materia > Initials > Group >  Max » | Std e > |Owt. Rate> Cost/Use = Accrue wj Base
Resource 1 Work R Consultants 100%  50.00/hr  $0.00/hr $0.00 Prorated | Standard
Resource 2 ork R Supervisors 100%  S0.00/hr  S0.00/hr $0.00 Prorated |24 Hours
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B2 Definition of Resources Names
The names that are specified for the resources can be:

Specific: people's names are used. Example: Juan Salas.

Generic: job or activity names are used. Example:
Operator. How to set up a resource as generic
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@Y Definition of Resources Names

Generic resources show an identification of “Generic
Resource” in the “Indicators” column

wnpuvalu ' run 1 sunsume o ames i niser

@ Resource Name  ~  Email Address ¥ Type > i > Initials _~ Group > Max. ~ Std.Rate v Ovt Rate v Cost/Use v Accrue ~ Ba
Juan Salas Work 1 Consultants 100%  $0.00/hr  5$0.00/hr $0.00 Prorated Sta
__ Operarios | \work ‘ Resource Infarmation X !
{iGenral] Costs | Notes | custom Fieids| 1- Enter the resource information in the view
Resource game: | Operarios | s [0 "Resource sheet.
Email: | | Group: ‘ Supervisars
mi | | Code: ‘
Material sk L .,

— p—
Generic I:‘ Budget

Defl - 2- If it is a generic name, select the resource
Rescurce availabilty , - and double-click.
Available From | Available To Units. 2] { Change Working Time ...
NA NA 100% 5
v 3- In the window "Information of the resource ”,

on “General”, check the box of "Generic".

Help Details... | | concel




@Y Definition of Resources Names

Generic resources show an identification of “Generic
Resource” in the “Indicators” colum

File Task Resource Report Project View Help Format £ Tell me what you want to «
o == 36 Cut = -
= B Calibri <[t || == wm mm mm mm ST Markon frack
Ganﬁ Paste = Coy =
Chart~ = ¥ Format Painter B I U O-A-
View Cligboard Font M5 Schedule
@  Resource Name  Enfgil Address * Type v Material v |nitials ~ Group ¥
1 Juan Salas Work | Consultants
2 |&3a Lo Work 0 Supervisors
&% Generic Resource
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@4 Availability of Resources

The availability of resources can be define using:
e Availability of units (expressed with percentages or
decimal units) for different periods of time.

e Use of a custom business calendar for the resource
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@4 Availability of Resources

Resource Infarmation x

GEHEFEI' Costs | Notesl Custom Fieldsl

Resource name; | Operarios Initials: ‘ 0 |

Email: | Group: | supervisors | 1- Enter the resource information in the view.
‘ Logon Account.., ‘ | | Code: ‘ | "Resource sheet".

Booking type: | Committed w | Type: | Work w |

Material [abel | |

Generic [ Budget

Default Assignment Qwner;

Inactive
Resource Availability 2. Select the resource and double click.
Available From | Available To Units iy Change Working Time ...
NA NA 100%

3. Find “Resource information” and the button
“Change working time...”.

Help Details... | | oK | | Cancel
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@9 Availability of Resources
When you select the "Change working time"
button, a window is displayed to
customize the base calendar e

Change Working Time

Legend:

° ° Click on a day to see its working times July 20, 2021 is nonworking
specifically, for the selected s ]|
) o S|M| T|WITh F|S
_ 128
: Nonworking
reSOu rce 4(5|/6|7(81|9 (10
ﬂ Edited working hours
o 111121314 \15(16 |17 Hasert one
On this calendar: + 18|19 52112223124
o [ 1 aaaaaaaaaaaaaaaaaaa
It can include your vacations =g SeaEE
’ JE Nandefault work week &

disabilities, schedule availability [~
for the project, etc

Finish
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@ Assign Resources to Tasks

The process of allocating resources to Tasks can be

performed in several ways:

1. By typing directly, the name of the resource in the
column "Resource Name" of the input table in the
Gantt Chart. If the resource entered does not exist in
the "Resource Sheet", it is incorporated into it.

Task Resource
ﬁ Mode = WBEBS » Task Name ~ Duration ~ Start ~ Finish ~ Predecessor » Total Slack ~| Names -
- ABC-A Project Start 0 days Fri 7/16/21  Fri7/16/21 0 days
-y ABC-B 4 Apartment 1 20 days Fri7/16/21 Thu8/12/21 0 days
- ABC-B-1 Prepare Apartment 1 5 days Fri7/16/21 Thu7/22/21 1 0 days Painter 1
- ABC-B-2 Paint Apartment 1 10 days Fri7/23/21 Thug/5/21 3 0 days
- ABC-B-3 Decoration Apartment 1 5 days Fri 8/6/21 Thu 8/12/21 4 0 days
- ABC-C 4 Apartment 2 20 days Fri8/13/21 Thu9/9/21 0 days
- ABC-C-1 Prepare Apartment 2 5 days Fri8/13/21 Thu8/19/21 5 0 days
- ABC-C-2 Paint Apartment 2 10 days Fri8/20/21 Thusg/2/21 7 0 days
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@ Assign Resources to Tasks

2. Selecting the resources from the drop list presented in
of the column " Resource Name " of the Gantt Chart.
Multiple resources can be separated by commas or
semicolons

- ABC-B-2 Paint Apartment 1 10 days Mon 7/26/21 Frig/6/21 3 0 days v
- ABC-B-3 Decoration Apartment 1 5 days Mon 8/9/21 Fri8/13/21 4 0 days [

@2 ABC-C + Apartment 2 20 days Mon 8/16/21 Fri 9/10/21 Odays || DJames Paterson
- ABC-C-1 Prepare Apartment 2 5 days Mon 8/16/21 Fri8/20/21 5 0 days =::::::;

-y ABC-C-2 Paint Apartment 2 10 days Mon 8/23/21 Frig/3/21 7 0 days

-

ABC-C-3 Decoration Apartment 2 5 days Mon 9/6/21 Fri9/10/21 8 0 days



Assign Resources to Tasks

3. Using the option "Assign resources”
1. In the Gantt Chart view, select the tasks.
2. Select Resource on Ribbon Menu and then Assign

resources.

3. Select the resources and then click “Assign”

sk Resource

@, o

“t:'-:. v(\;)
Assign  Resourcse
Resources Pool ~

Report

Project View  Help

Details

Format

£ Tell me what you want to do
- ‘.‘- - [] Leveling Options
- 5 Clear Leveling
Level Level  Level

i N
Selection Resource Al nii Next Overallocation

Properties Level
Task Resource
0 Mode =+ WBS + Task Name Duration ~ Start ~ | Finish ~ Predecessol »  Total Slack ~ | Names -
- ABC-A Project Start 0 days Fri7/16/21  Fri 7/16/21 0 days
ABC-B 4 Apartment 1 21 days Fri7/16/21 Frig/13/21 0 days
- ABC-B-1 Prepare Apartment 1 5 days Fri7/16/21  Fri7/23/21 1 0 days Builders
- ABC-B-2 Paint Apartment 1 10 days Mon 7/26/21 Fri8/6/21 3 0 days Painter 1,Painter 2
- ABC-B-3 Decoration Apartment 1 5 days Mon 8/9/21 Fri8/13/21 4 0 days
—
- ABC-C 4 Apartment 2 20 days Mon 8/16/21 Fri 9/10/21 0 days
- ABC-C-1 Prepare Apartment 2 5 days Mon B/16/21 Fri8/20/21 5 0 days
- ABC-C-2 Paint Apartment 2 10 days Mon B/23/21 Fri9/3/21 7 0 days
- ABC-C-3 Decoration Apartment 2 5 days Mon B/6/21 Fri9/10/21 8 0 days
- ABC-D 4 Aparti t 3 20d M
BRI Ay o Assign Resources X
- ABC-D-1 Prepare Apartment 3 5 days Mon
- ABC-D-2 Paint Apartment 3 10 days M | Muftiple tasks seledted (7.8,3)
+ | Resource [ist options

- ABC-D-3 Decoration Apartment 3 5 days Mon
- ABC-D Project End 0 days Fri 10) Resources from Practice W1

Resource Name R/D | Units |Cost

Builders

TEMEs Paterzon

:Painter 1

|Painter 2 piace
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@ Leverage Resource Usage
It can be identified that a resource has
work overload (it has scheduled the execution of at least two
tasks at the same time), when we see the resource with red
letters in the "Resource Sheet"

Task Resource Report Project View Help Format £ Tell me what you want to do
e® @ D re E ® mm [ Leveling Options
& & | BE & T : _
. i > Clear Leveling
Resource Add Information Motes Details Level Level
Pool - Resources - Resource  All
Assignments Insert Properties Level
0 Resource Name » | Email Address > | Type - Materia w* Initials v Group » Max. > Std.Rate » Ovi Rate v Cost/Use > Accrue  » Base b
James Paterson Work J Consultants 100% S0.00/hr  S0.00/hr $0.00 Prorated Standard
&% Builders Work B Supervisors 100%  S0.00/hr  $0.00/hr $0.00 Prorated Standard
- Painter 1 Work = Painters 100%  $0.00/hr  $0.00/hr $0.00 Prorated Standard
Painter 2 Work P Painters 100% $0.00/hr  $0.00/hr $0.00 Prorated Standard

Work 100%  S0.00/hr  $0.00/hr $0.00 Prorated Standard
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@Y Leverage Resource Usage

The overload of work drives the need to leverage the use of
resources. This can be done by delaying or dividing the
conflicting task (s).
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@ Leverage Resource Usage

To do this automatically, you can use the redistribution
options in MS Project.

Resource  Report Project View Help Format 2 Tell me what you want to do

." .:. | [ee=| = aam - Leveling Options
¥ [ %= >m = . )

: 2 > Clear Leveling
sign Resource C formation Motes Details Leve Level Level .

= Raconiod Solaction il Next Overallocation .

dhee i fom : priecim Bemles Ak 1- Select Resource on Ribbon menu
Assignments Insert Properties Leve| |

Task Resource Leveling X

Mode ~ WBS ~ Task Name ~ Duration -

- ABC-A Project Start 0 days Leveling calculations

- ABC-B 4 Apartment 1 21 days O automatic (® manual

- ABC-B-1 Prepare Apartment 1 5 days Lock for pverallocations on a basis

- ABC-B-2 Paint Apartment 1 10 days Clear leveling values before leveling

= ABC-B-3 Decoration Apartment 1 5 days Leveling range for ‘Practice W1' . .

£ ¥ grang 2. Select Leveling Options

- ABC-C 4 Apartment 2 20 days (@) Level entire project

- ABC-C-1 Prepare Apartment 2 5 days O Leyel From: | Fri 7/16/21

- ABC-C-2 Paint Apartment 2 10 days To: | Fri 10/8/21

- ABC-C-3 Decoration Apartment 2 5 days Resolving overallocations

- ABC-D < Apartment 3 20 days vevellng order:

- ABC-D-1 Prepare Apartment 3 5 days [Level only within available slack .
- ABC-D-2 Paint Apartment 3 10 days [ bewling ean it AR Se e e Atk 3. Select the resources and then check Automatic
- ABC-D-3 Decoration Apartment 3 5 days Leveling can create splits in remaining work Leveli ng ca Iculations

L - ABC-D Project End 0 days [Level resources with the proposed booking type

Level manually scheduled tasks
| Help | | Clear Leveling... | | Level All | | oK ‘ Cancel
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@Y Leverage Resource Usage

Automatic Leveling

If you select automatic Leveling, Project automatically
redistributes the work, as conflicts occur, according to the

parameters selected in this window.

e vl 1
Look for overallocations on a ‘ Day by OBy ~ | basis

vl clear Ieveﬁﬁg values be?ore eveling

veling range for 'Practice W1'

=

(I vel e pJCt
) vel

Resolving overallocations

eling order: Standard ~

evel only within available slack

Leveling can adjust individual assignments on a task
eveling can create splits in remaining work

evel resources with the proposed booking type
evel manually scheduled tasks

Help Clear Leveling Level All Cancel

KIORIRIO §
RILIKIRIL
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@ Leverage Resource Usage

Manual Leveling

If you select manual redistribution, you must check for overhead
and run the process manually.

Resource Leveling x

Leveling calculations

OAutomatl’c @Manual

Look for gverallocations on a | Day by Day . | basis

Clear leveling values before leveling

Lewveling range for 'Practice W1'
(@ Level entire project
O Level Fromr | Fri7/156/21

Resolving overallocations

Leveling order: Standard v

D Level only within available slack
Leveling can adjust individual assignments on a tagk
Leveling can create splits in remaining work

D Level resources with the proposed booking type
Level manually scheduled tasks

Help Clear Leveling.. Level All OK Cancel
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@ Leverage Resource Usage

Leveling Parameters

You can select from drop list the leveling order by Standard, Id

only, priority standard

Resource Leveling

Leveling calculations
OAutomatic @Manual

Look for gverallocations on a | Day by Day V| basis

Clear leveling values before leveling

Lewveling range for 'Practice W1'
(@ Level entire project
O Level Fro Fri 7/16/21

Resolving overallocations

Leveling order: Standard ~

D Level only within available slack
Leveling can adjust individual assignments on a tagk
Leveling can create splits in remaining work

D Level resources with the proposed booking type
Level manually scheduled tasks

Help Clear Leveling.. Level All Ok

Cancel
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Leverage Parameters

Leveling order
e |dentifier only (ID only): Of the tasks in conflict, the one with

the lowest ID number is scheduled as the first task, the next is
rescheduled later.

e Standard: The longest duration is scheduled first.

e Priority, standard: They are scheduled according to
to the priority of the tasks. If the task has the same priority,
the one with longest duration is scheduled first.



Leveling Parameters

Redistribution can create division in the remaining work: If this
option is selected, if any task needs to be rescheduled and has
already started, it allows to divide the execution of the
remaining work.

Level All: Selecting this button executes the redistribution of all
overallocated tasks.

If you select manual redistribution, you must check for
overhead and run the process manually.



@ Leverage Resource Usage

Other Options on the Resource Tab

Level All: Level all selected tasks

Level resources: Level the tasks for the selected resources

Task | Resource
& @

Assign Resource
Resources Pool -

Assignments

Report

Insert

Project

View Help Format

Properties

£ Tell me what you want to do

Level|

Level

Resource  All

Level

B Leveling Options
»7] Clear Leveling

E s
il Next Overallocation




Clear Leveling: Deletes any previously added redistribution
settings.

Next over-allocation: It leads to the next task line where there
is over-allocation of resources.

Task Resource Report Project View Help Format £ Tell me what you want to do

e® e® ’_——‘ ‘.‘- mm | 5] Leveling Options
s a5 == >m |, :

; ; : »® Clear Leveling
Assign  Resource ' Details Level Level . _
Resources Pool - Resource All | mii Next Overallocation

Properties Leve|

Assignments Insert
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